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Introduction to Enterprise Edge Attendant 
Console

Enterprise Edge Attendant Console is an application that provides centralized
management and call activity reporting capability to a business. Enterprise E
Enterprise Edge Attendant Console runs on one or more Pentium® Class personal 
computers (PCs).

You can customize the way Enterprise Edge Attendant Console is set up to sui
company’s call management requirements. A telephone attendant uses the 
graphical user interface to:

• originate calls

• answer and manage multiple calls

• view a company’s name before answering the call

• record, add and change caller information for future use

• quickly access information about the caller

• transfer calls to employees or their voice message mailbox

• send the caller’s name to the employee’s Enterprise Edge telephone disp

• park calls and page employees

• view information in a Directory about your company’s employees such as t
extension number, person status and telephone status

• create and print reports showing how incoming calls are handled

• view the status of all extensions in the company’s Enterprise Edge Attend
Console system

1
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About this guide
This document describes how Enterprise Edge Enterprise Edge Attendant Co
works and how to use it in your company. The instructions in this guide are inte
for experienced PC users. The Enterprise Edge Attendant Console User Guide is 
organized as follows:

Conventions

Naming of window components
Refer to Components of the Attendant window on page 25 for window terminology
used in this document.

Using the keyboard to navigate Enterprise Edge Attendant Console 
You can use the keyboard to do many tasks quickly in Enterprise Edge Atten
Console. There are three kinds of keyboard navigation. The first two types ar
Windows standard while the third type is particular to Enterprise Edge Attend
Console. They are:

• Access keys, which are the letters underlined in menu names and comma
For more information, refer to Access keys on page 9.

• shortcut keys defined on the menus. For more information, refer to Shortcut 
keys defined on the menus on page 9.

• commands initiated by pressing the Alt key and another key. For more 
information, refer to Commands initiated by holding down the Alt key and a
additional key on page 9.

Introduction to Enterprise Edge 
Attendant Console

provides an overview of how this guide is organized,
offers references and discusses using shortcut keys a
right-click mouse capability.

Understanding 
Enterprise Edge Attendant Console

explains how Enterprise Edge works and explains the
features available with Enterprise Edge Attendant 
Console. 

Getting started describes how to start, minimize, maximize and clo
the Attendant component and how to change the 
different Attendant setups.

Working with the Attendant 
window

explains the components of the Enterprise Edge 
Attendant Console Attendant window.

Handling calls explains how an attendant answers and directs 
incoming calls and how a person being called answe
and manages calls.

Maintaining caller and employee 
information

describes how you enter, edit and maintain caller and
employee information.

Generating reports explains how to use the Reports component to gene
and customize reports.

Glossary defines terms and acronyms used in this guide that 
relevant to Enterprise Edge Attendant Console.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01
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Access keys

In Enterprise Edge Attendant Console, each menu name and each command
menu has an underlined letter called an Access key.

To use the Access keys:

1. Press and release the Alt  key.
This gives you access to the menu names in the menu bar.

2. Press the Access key for the menu name and release it. For example, to op
Edit menu, press Alt  then E and the Edit menu is displayed.

3. Press the Access key for the desired command. For example, to select Ca In-
formation from the Edit menu, press I  and the Edit Caller Information dialog 
box is displayed.

Shortcut keys defined on the menus

Shortcut key combinations are shown beside some menu commands. When y
the Ctrl key with another key, hold the Ctrl key down while pressing the second
in the combination. The additional shortcut keys are:

In the Edit menu:

In the Transfer menu:

In the Caller menu:

Commands initiated by holding down the Alt key and an additional key

You can access Call handling functions directly from the Attendant window b
pressing the Alt key and the underlined keys in the commands. You must hold d
the Alt key while you press other key. For example, to place an active call on H
hold down the Alt  key and press H.

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Dial Paste Ctrl+D

Transfer Paste Ctrl+T

1st Contact F9

2nd Contact F10

3rd Contact F11

Transfer to Target Num Pad+

Screen Transfer Ctrl Num Pad+

Answer Next Esc

Hold Ctrl+H

Release F12
P0908544 Issue 01 Enterprise Edge Attendant Console User Guide
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Processing a call with right-click capability
Right-click capability helps you process calls faster by minimizing mouse 
movement. You can use right-click capability for these call processing option

• originate a call

• transfer a call

• screened transfer

• transfer a call to voice message mailbox

• link transfer

• park a call and page an employee

• camp a call on an extension

To use right-click capability:

1. Click a name or extension in the Directory  list and right-click the mouse. A 
list of call processing commands appears.

2. Click one of the call processing commands.

References
As an Enterprise Edge attendant, you can refer to the Enterprise Edge Attendant 
Console Set Up and Operation Guide for more information about Enterprise Edg
Attendant Console.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01
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Understanding Enterprise Edge Attendant 
Console

Enterprise Edge Attendant Console is a client/Enterprise Edge server softwa
application that consists of the following three interrelated components:

• Server component. Refer to Server component on page 11

• Attendant component. Refer to Attendant component on page 11

• Reports component. Refer to Reports component on page 12

Server component
The Server component communicates with your Enterprise Edge server initia
Enterprise Edge telephone functions such as transferring calls, placing calls on
and parking calls.

The Server component communicates with one or more Attendant component
Attendant component can be either on the same PC as the one with the Serv
component or on a separate PC connected via a Local Area Network (LAN).

The Server component receives:

• notification of all incoming calls

• status changes of all telephones attached to the Enterprise Edge server

The Server component collects and manages call-processing information in a
database that can be used for reporting purposes.

Attendant component
The Attendant component has an easy-to-use graphical user interface. The 
Attendant window displays information about incoming callers and includes a
Company Directory with employee names, telephone status (such as on-hoo
hook, do not disturb and call forward) and personal status (None, Not at desk
Out of office). The Directory can be searched from the Attendant window.

Attendant PCs can be either main, assistant, overflow or backup. For more 
information, refer to Types of attendant setups on page 17. Incoming calls can be
transferred to an extension, a voice message mailbox or an external number.

You can set up your company with more than one attendant. You can also se
Enterprise Edge Attendant Console to provide call coverage for assigned grou
employees. In this setup, you are notified of calls to assigned employees and
answer calls when the employees cannot.

2
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Reports component
The Reports component provides information about incoming calls to your 
company. Reports can help you identify trends and find answers to questions b
they become problems. You can request a report from any PC with an Attend
component and view the report in the Reports window or print it on an attach
printer.

Enterprise Edge Attendant Console features
There are many features and benefits associated with Enterprise Edge Atten
Console.

Easy to use, time saving Graphical User Interface (GUI)
Enterprise Edge Attendant Console has a GUI that is uncomplicated compared
other attendant consoles, without sacrificing sophisticated features. You can e
select the correct buttons to process incoming calls and very few key strokes
required for most everyday activities. In fact, answering an incoming call and
transferring it to an extension usually requires only two steps: clicking a Loop
button to answer the call and double-clicking the icon beside the called party’
name to transfer the call.

The GUI provides you with at-a-glance information about the progress and st
of calls. Even before a call is answered, you are provided with advance inform
about the call and caller, including the caller’s telephone number and the leng
time that the caller is waiting. If calls transfer back to you, the Attendant wind
immediately displays the status of the call.

The readily available on-line help ensures that Enterprise Edge Attendant Co
is easy to learn and to use.

Because performing normal attendant functions is faster with a GUI, you can
other tasks.

Advanced software capabilities
Here are some of Enterprise Edge Attendant Console’s advanced software 
capabilities:

Visual call announcing and 
control

Even when a telephone is busy with a call, an attendant can 
send caller information to the telephone’s two-line display are
Using display buttons, the person called can control the call 
accordingly. This is a unique feature because it means that 
important calls are not lost.

Backup attendant Incoming calls can be quickly and easily transferred to a bac
attendant sitting at a different location than the main attendan
This means that the backup attendant does not have to leave
their desk to cover for the main attendant.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01
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Attractiveness of PC compatibility
Enterprise Edge Attendant Console combines telecommunications with perso
computing to make the attendant’s job easier, faster and more efficient.

Attendant types
Each PC that has the Attendant component installed is set up to handle calls 
as a main attendant, overflow attendant, backup attendant or assistant attend
Each attendant type gives you flexibility in responding to calls. This ensures th
calls can be handled in a professional and timely manner. For detailed inform
about attendant setups, refer to Types of attendant setups on page 17.

Overflow attendant Overflow calls are transferred to an overflow attendant. 
Consequently, calls are not lost during busy periods.

Reports Enterprise Edge Attendant Console gives you reports that h
you obtain information such as the number of incoming calls 
and who answers the calls. This information shows the callin
trends in the business and the performance of the telephone 
system.

Ability to handle growth A one-time purchase of Enterprise Edge Attendant Console
often all that is needed. If you want to add more attendant 
positions as the company grows, Enterprise Edge Attendant 
Console is easily expandable.

Use of existing hardware There is no need for you to purchase additional dedicated 
hardware to obtain the power of Enterprise Edge Attendant 
Console. If you have the minimum computer requirements, a
you need is the software and a hardware enabler that allows 
your computer to communicate with the Enterprise Edge serv

Multi-tasking Enterprise Edge Attendant Console works in a multi-tasking 
environment. You can use your PC for other tasks such as wo
processing in addition to attending to calls. You can quickly 
switch from PC tasks to the Attendant window if there is an 
incoming call.
P0908544 Issue 01 Enterprise Edge Attendant Console User Guide
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Getting started

After your Enterprise Edge Attendant Console system is set up and checked b
installer or System Administrator, you can use the Enterprise Edge Attendant
Console components. Before you handle calls, make sure you know how to sta
quit Enterprise Edge Attendant Console on your PC. For information on startin
components for the first time, refer to Initializing and configuring the Attendant 
component on page 16.

Starting the Attendant component
For information about changing the Attendant window settings refer to Initializing 
and configuring the Attendant component on page 16.

To start the Attendant component and open the Enterprise Edge Attendant Co
Attendant window:

1. On the Attendant PC, click Start and point to Programs, point to Nortel 
Networks, point to Attendant Console and then click Attendant.
The Enterprise Edge Attendant Console Attendant taskbar button appears
the taskbar. The Enterprise Edge Attendant Console Attendant window ap
with the Tip of the Day window over it.

2. On the Tip of the Day window click the Close button.

Minimizing and maximizing the Attendant window
You can minimize and maximize the Attendant window depending on your ne

To minimize the Attendant window:

1. In the title bar click Minimize   . The Attendant window minimizes.

To maximize the Attendant window:

1. On the taskbar, click the Enterprise Edge Attendant Console Attendant 
taskbar button.
The Attendant window returns to full size.

3
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Quitting the Attendant component
To quit the Attendant component:

1. On the File menu click Exit
or
on the title bar click the Close box.
A message appears asking if you want to quit Enterprise Edge Attendant 
Console.

2. Click the Yes button.

You can also shut down the Attendant component from the Windows taskbar
right-clicking the Enterprise Edge Attendant Console Attendant taskbar button 
and clicking the Close button.

Initializing and configuring the Attendant component
Each PC that has the Attendant component installed must be set up to handl
either as a full-time main attendant, part-time main attendant, backup attenda
overflow attendant or assistant attendant.

Starting the Attendant component for the first time
To start and set up the Attendant component:

1. On the taskbar, click Start, point to Programs, point to Enterprise Edge 
Attendant Console and click Attendant. 
The Attendant component starts. The first time the Attendant component 
started after installation, the Enter Attendant Options dialog box appears.

2. In the Attendant Extension box type the extension number of the attendan

3. If the network has more than one Enterprise Edge Attendant Console Ser
running, you must enter the Server ID for the Enterprise Edge server you 
to use in the Server ID  box.
The Server ID refers to the Windows TCP/IP host name of the Server PC
information about how to determine the Server ID, refer to Determining th
TCP/IP host name of a Server PC in the Enterprise Edge Attendant Console 
Installation Guide. If there is only one Enterprise Edge Attendant Console 
Server running, leave this box blank and the Attendant component 
automatically connects to that Server component.

4. Click the OK button.
The Tip of the Day dialog box appears over the Enterprise Edge Attendan
Console Attendant window.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01
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5. Click the Close button to see the Enterprise Edge Attendant Console Attend
window.

When the setup is complete, the  Directory list displays the Enterprise Edge 
extensions connected to the Enterprise Edge server.

Types of attendant setups
Each PC that has the Attendant component installed must be set up to handl
either as a main attendant, overflow attendant, backup attendant or assistant
attendant.

Full-time main attendant setup

The full-time main attendant setup is intended for a telephone operator that ha
Attendant window always visible on their PC. There can be more than one full-
attendant.

Every Attendant component must have the Server ID and Attendant extensio
options set correctly for the Attendant component to function. The Server ID 
indicates to the Attendant component where the Server component is located
Attendant extension setting indicates to the Attendant component which Enter
Edge telephone belongs to the attendant.
P0908544 Issue 01 Enterprise Edge Attendant Console User Guide



18  Getting started

one 

at is 
those 

s 
 valid 

r 

n the 

ain 
lected 

cted 
perate 
 types.

direct 

 

ndant 

t can 
pear 

’s PC. 
calls, 
The Attendant component displays all incoming calls to the attendant’s teleph
as a yellow Ringing Loop button on the Attendant window. If the attendant’s 
telephone is programmed to receive all the incoming calls for the company, (th
as a main attendant) Enterprise Edge Attendant Console Attendant displays 
calls.

Before the attendant can receive and make calls, you must set the attendant’
extension number through the Attendant component. The extension must be a
extension on the Enterprise Edge system and must be the telephone at the 
attendant’s desk.

To set or change the attendant’s extension number:

1. On the Tools menu click Options. 
The Options dialog box appears with the Options tab open.

2. In the Attendant option, in the My Extension box, type the extension numbe
of the attendant’s telephone.

3. Click the OK  button.

Part-time main attendant setup

The part-time main attendant can answer incoming calls and performs tasks o
PC such as word processing.

The difference between the full-time main attendant setup and the part-time m
attendant setup is that the part-time setup has additional Attendant options se
that allow notification of incoming calls when the attendant component is 
minimized. Refer to Full-time main attendant setup on page 17 and Setting up other 
attendant features on page 21.

Backup attendant setup

A backup attendant is an attendant position that receives calls that are redire
from another attendant position. The backup attendant can at the same time o
as a main attendant, assistant attendant, or any combination of the attendant

Each Attendant PC that is set up to receive incoming calls must be set up to re
the calls to the backup Attendant PC.

Note: Calls can be redirected to another Enterprise Edge Attendant Console
attendant or any Enterprise Edge extension in the company.

If the attendant needs to leave their position, they can activate the backup atte
position by clicking the Out button on the Attendant window. The Out button 
diverts calls to the backup attendant. After clicking the Out button, the attendan
complete the calls currently in progress on the Attendant window. New calls ap
on the absent main attendant’s PC and also appear on the backup attendant
Although the main attendant is out, the Attendant component can still process 
if required.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01
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To set up the backup attendant:

1. On the Tools menu click Options.
The Options dialog box appears with the Options tab open.

1. In the Redirect calls to option in the Extension box, type the backup 
attendant’s extension number.

2. Click the OK  button.

The main attendant can redirect their calls to the backup attendant by clicking
Out button. The main attendant can click the In button to resume receiving ca
their PC.

Overflow attendant setup

An overflow attendant receives calls are redirected from another attendant po
when there are more incoming calls than Loop buttons on the other attendan
position. For example, if a main attendant is already handling six incoming ca
the next call is redirected to the overflow attendant until one of the main attend
six Loop buttons is available.

The overflow attendant can also operate as a main attendant, an assistant att
or any combination of the attendant types.

After you set up an Attendant PC as the overflow, each Attendant PC that is s
to receive incoming calls must be set up to redirect calls to the overflow Atten
PC whenever overflow conditions exist. You must activate the overflow featur
each Attendant PC.

Note: Calls can be redirected to another Enterprise Edge Attendant Console
attendant or any Enterprise Edge extension.

If all the Loop buttons are in use, the Loop overflow icon appears in the Attendan
Status Bar and the overflow call goes to the specified extension. For more 
information on the Loop overflow icon, see Status Bar on page 27.

To set the overflow extension:

1. On the Tools menu, click Options.
The Options dialog box appears with the Options tab open.

2. In the Redirect calls to option, in the Extension box, type the overflow 
attendant’s extension number.

3. Select Call overflow occurs to redirect calls when all of the main attendant’
Loop buttons are busy with calls.

4. Click the OK  button.
P0908544 Issue 01 Enterprise Edge Attendant Console User Guide
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Assistant attendant setup

An assistant attendant provides call coverage for one or more extensions in t
system. You can set up an assistant attendant to monitor incoming calls to sp
extensions. Set up an assistant attendant if an employee wants an assistant 
attendant, such as an administrative assistant, to answer the employees’ call

To set up an assistant attendant:

1. On the Tools menu, click Options.
The Options dialog box appears with the Options tab open.

2. In the My extension box, type the assistant attendant’s extension.

3. Click the OK  button.

To add or remove an assistant attendant’s assigned extensions:

1. On the Tools menu, click Options.
The Options dialog box appears with the Options tab open.

2. Click the Assigned tab.

To add an extension, click the extension you want in the All extensions box and 
click >> to copy it to the Assigned extensions list.

To remove an extension from the Assigned extensions list, click the exten
number in the Assigned extensions list and click <<. 

To view an assistant attendant’s assigned extensions:

1. On the Tools menu, click Options.
The Options dialog box appears with the Options tab open.

2. Click the Assigned tab.

3. After you view the extensions, click the OK  button.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01
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Setting up other attendant features

Call notification

There are two ways Enterprise Edge Attendant Console can notify an attenda
incoming calls:

• If an attendant keeps the Attendant window minimized and works on othe
tasks, they are notified of incoming calls with a Call Notification dialog box. 
The attendant can answer the call by clicking Take on the dialog box or ignore
the call and let another attendant answer it.

• If the Attendant window is not minimized, the attendant is notified of an 
incoming call by Ringing Loop button.

To activate call notification:

1. On the Tools menu click Options.
The Options dialog box appears.

2. In the Pop “Call Notification” dialog box when list, click either check box:

Assigned extension rings - The attendant is notified of calls to the assigned
extensions.

or

My extension rings -The attendant is notified when their own extension has
incoming call.

If both check boxes are clear, the attendant is not notified of calls when th
window is minimized.

3. Click the OK  button.

When an outside call arrives for an assigned extension, a Call Notification dia
box appears to inform the assistant attendant of the call. Internal calls from a
extension to an assigned extension are not displayed on the assistant attend
window.
P0908544 Issue 01 Enterprise Edge Attendant Console User Guide
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Automatically restoring the Attendant window when a call comes in

Part-time attendants can have the Attendant window minimized or under ano
window. The attendant can restore the Attendant window from the taskbar by
clicking the Enterprise Edge Attendant Console Attendant taskbar button. A 
quicker method is to set the Attendant window to restore automatically.

The Attendant component can automatically restore the window when the 
attendant’s extension goes off-hook (“active”).

To set the Attendant window to restore automatically:

1. On the Tools menu click Options.
The Options dialog box appears with the Options tab open.

2. In the Restore minimized Attendant screen when option, click the Call 
Answered on Attendant extension check box.

3. Click the OK  button.

When an outside call arrives for an assigned extension, a Call Notification dia
box appears to inform the assistant attendant of the call. Internal calls from a
extension to an assigned extension are not displayed on the assistant attend
window.

Setting the Attendant Selected option

The Selected tab lets the attendant can view a selected subset of the full dire
This is useful if the attendant’s incoming calls are directed to a limited numbe
extensions.

To display selected extensions in the Directory list of the Attendant window:

1. On the Tools menu click Options.
The Options dialog box appears with the Options tab open.

2. Click the Selected tab.

3. To add an extension, click the extension you want in the All extensions list and 
click >> to copy it to the Selected extensions list.

To remove an extension from the Selected extensions list, click the exten
number in the Selected extensions list and click <<.

4. Click the OK  button.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01
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Setting Transfer options for the voice message mailbox and linking

If your Enterprise Edge server is not connected to a Centrex switch or is not 
connected to Enterprise Edge Voice Messaging, you can disable the Link Tra
or VM Transfer buttons on the Attendant window.

To disable the Transfer Options:

1. On the Tools menu click Options.
The Options dialog box appears with the Options tab open.
The Transfer Options are in the bottom right of the dialog box.

2. Select the Disable VM Transfer check box to disable the VM Transfer butto
or
select the Disable Link Transfer check box to make disable the Link Transfe
button.

If they are disabled the buttons appear dimmed on the Attendant window. You
re-enable the buttons by clearing the check mark from the appropriate check
P0908544 Issue 01 Enterprise Edge Attendant Console User Guide
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Using the Attendant window

This section explains how to use the buttons and options on the Enterprise E
Attendant Console Attendant window with the mouse and the keyboard.

Components of the Attendant window
The Enterprise Edge Attendant Console Attendant window contains:

Components of the Attendant window

Title bar
The title bar is at the top of the Attendant window. The program icon that app
on the left side of the title bar when clicked contains: Restore, Move, Size, 
Minimize, Maximize, and Close. The telephone icon and the program title, 
Enterprise Edge Attendant Console Attendant is displayed. On the right side a
Windows standard Minimize, Maximize and Close buttons.

4

title bar menu bar Loop buttons toolbar Caller Information 
options

Directory options

Call processing area

Status bar Directory list
P0908544 Issue 01 Enterprise Edge Attendant Console User Guide
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Menu bar
The menu bar is under the title bar and contains the File, Edit, View, Tools, 
Transfer, Caller, Target, Attendant and Help menus. Use these menus to acc
Attendant functions.

Toolbar
The toolbar is under the menu bar and contains several buttons that provide 
and easy access to some Enterprise Edge Attendant Console functions.

Loop buttons
The Loop buttons on the left of the Attendant window are labeled F1, F2 and s
and are used to answer calls. Each Loop button can handle a single call. The
button has a color and a word that represents its type of call activity. For exam
a yellow Loop button with the word Ringing represents an incoming call at the
attendant’s extension. For information on how to hide or display the Loop but
except for those that indicate call activity refer to View menu on page 29.

Caller Information options
The Caller Information options is in the top center of the Attendant window an
displays information about the caller that is stored in the Enterprise Edge ser
database.

Call processing area
Use the Target list box and the Call Processing buttons at the top right of the
Attendant window to make and transfer calls.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01
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Directory list
The Directory list is at the bottom of the Attendant window and has three sect

Status Bar
To display the Status Bar:

1. Click View and then click Status Bar.

The Status Bar contains:

Directory list displays the Name, Extension, Notes and Department of 
extensions. From the directory list you can select a name and 
number to appear in the Target list box. The Directory list 
also shows the telephone status icon and the person status 
icon for extensions.

Note and Status list boxes let you change the status of the employee and include a note 
for an extension.

Find and Department boxes
Show All and Edit buttons

search for extensions and edit employee information and 
extension records.

Displays the functions of the toolbar button when you 
point at it.

The Loop Overflow icon appears if there are more calls 
waiting to be answered than available Loop buttons.

Appears if the Num Lock key is on.

Shows date and time.
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Using the menu bar
The menu bar contains the menus on the Enterprise Edge Attendant Console
Attendant window. Help tips appear in the Status bar at the bottom of the Atten
window if you move the mouse pointer over the commands in the menu.

File menu

The File menu contains:

Edit menu

The Edit menu contains:

Exit closes the Attendant component.

Cut cuts selected text from an editable box and moves it to the 
Clipboard.

Copy copies a selection of text from an editable box and moves it 
to the Clipboard.

Paste inserts the Clipboard contents at the insertion point.

Dial Paste dials the number in the Clipboard. The number can include 
special characters such as hyphen, parenthesis, space or 
period.

Note: The Clipboard contents are added to any characters 
already in the Target list box. This allows you to type 
a routing code in the Target list box first and then 
click the Dial Paste button.

Transfer Paste transfers a call to the number in the Clipboard.

Caller Information opens the Edit Caller Information dialog box. The Edit button 
in the Caller Information list performs the same function. 
Refer to The Edit Caller Information dialog box on page 36 
and Maintaining caller information on page 63.

Employee Information opens the Edit Employee Information dialog box. The Edit 
button in the Directory list performs the same function. Refer 
to The Edit Employee Information dialog box on page 40 
and Maintaining employee information on page 67.
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View menu

The View menu contains:

Tools menu

The Tools menu contains:

Toolbar shows/hides the toolbar.

Status Bar shows/hides the Status Bar.

Hide Loop Buttons shows/hides the inactive Loop buttons. When selected, only 
active Loop buttons appear on the Attendant window.

Reports starts the Reports component.

Attendant Monitor opens the Attendant Monitor dialog box that displays 
diagnostic information sent by the Attendant component and 
received back from the Server component. The Attendant 
Monitor helps in troubleshooting. 

Log to File writes Attendant component activity and Server messaging to 
a log file. This is used for troubleshooting.

Options opens the Options dialog box, which has three tabs.

The Options tab:
lets you specify the Server ID, enter the Attendant extension, 
set the conditions for making the Enterprise Edge Attendant 
Console Attendant window appear, and set call redirection.

The Assigned tab:
lets you choose extensions to appear in the Assigned tab 
contained in the Directory list on the Attendant window.

The Selected tab: 
lets you choose extensions to appear in the Selected tab 
contained in the Directory list of the Attendant window.

For more information, refer to Using the Directory options on 
page 38.
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Transfer menu

The Transfer menu contains:

1st Contact transfers the active call to the caller’s first contact.
1st Contact is enabled if there is an active call and a contact 
displayed in the first box of the Contacts list.

2nd Contact transfers the active call to the caller’s second contact.
2nd Contact is enabled if there is an active call and a contact 
displayed in the second box of the Contacts list.

3rd Contact transfers the active call to the caller’s third contact.
3rd Contact is enabled if there is an active call and a contact 
displayed in the third box of the Contacts list.

Transfer to Target transfers the active call to the extension in the Target list box. 
The Transfer button performs the same function.

Screen Transfer screens a call transfer of an active call to the extension 
number in the Target list box. The caller is automatically put 
on hold when you click Screen Transfer. The caller is 
connected when you click Transfer Now in the Screen 
Transfer dialog box. The Screen button performs the same 
function.
Refer to Parking, holding and screening calls on page 51.

Transfer to VMail transfers the active call to the voice message mailbox of the 
extension in the Target list box. The VMTransfer button 
performs the same function.
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Caller menu

The Caller menu contains:

Answer Next answers the next call in the queue.

Hold places an active call on hold. The Hold button performs the 
same function. Refer to Parking, holding and screening calls 
on page 51.

Release disconnects the active call. The Release button performs the 
same function.

Park parks the active call so you can page the person whose 
extension is in the Target list box. A list of all parked calls 
appears in the Parked Calls dialog box when you click View 
Parked Calls on the Caller menu. You can retrieve the call 
from the View Parked Calls dialog box by pressing the 
Retrieve button. For more information on viewing parked 
calls, refer to Parking, holding and screening calls on page 
51. The Park/Page button performs the same function.

Join Caller connects two callers by joining the active call with the call 
that is on hold. Refer to Linking and Joining calls on page 
56.

View Parked Calls opens the Parked Calls dialog box, which displays calls 
parked by all attendants. A call can be retrieved by any 
attendant or from any telephone on the Enterprise Edge 
server. For more information, refer to Parking, holding and 
screening calls on page 51.
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Target menu

The Target menu contains:

Attendant menu

The Attendant menu contains:

Call initiates a call from the attendant extension to the number in 
the Target list box. The Call button performs the same 
function.

Voice Call places a voice call from the Attendant to the extension in the 
Target list box. For more information, refer to Contacting 
employees using Voice Call on page 55.

Dial DTMF Tones dials DTMF-tone digits to the external number in the Target 
list box. This must be used in conjunction with the Link button 
and with outdialing on an active line to access other systems 
or carriers (for example, Centrex).

Link accesses (hookflash) Centrex/CO line features (such as off-
premise transfer or conference) or other systems or carriers 
while on an incoming call. Clicking the Link button while on 
an incoming call places the caller on hold and generates a 
Link signal (also called flash or recall) on the active line. The 
DTMF button is used with the Link button to outdial the digits 
in the Target list box. For more information, refer to Linking 
and Joining calls on page 56.

In toggles with the Out command. When set to In, the attendant 
is in position to take calls.

Out toggles with the In command. When set to Out, the attendant 
is not in position to take calls. All calls that ring at the 
attendant’s telephone are forwarded to the backup attendant 
position.

Note: To redirect calls to a backup extension, on the 
Tools menu click Options. Set redirect options on 
the Options dialog box.
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Help menu

The Help menu contains:

Using the toolbar
The toolbar contains several buttons that provide quick and easy access to so
the Enterprise Edge Attendant Console functions.

To display the toolbar:

1. Click the View menu and then click Toolbar.
The toolbar is displayed across the top of the Attendant window below the
menu bar.

The toolbar buttons are:

Tip of the Day shows or hides the Tip of the Day window when Attendant 
starts.

Attendant Help displays Help files.

About Attendant displays program information, revision number, copyright 
information, and system information.

Use the In and Out buttons to indicate whether or not you 
can take calls.

Use the Link button to access Centrex/CO line features (such 
as off-premise transfer or conference) or other systems or 
carriers while on an outside call. For more information, refer 
to Linking and Joining calls on page 56.

Use the DTMF button to dial DTMF-tone digits to the external 
number in the Target list box. This must be used in 
conjunction with the Link button and with outdialing on an 
active line to access other systems or carriers such as 
Centrex. This button also sends special characters (for 
example, *, #) from the Target list box to other services such 
as Interactive Voice Response (IVR) and Enterprise Edge 
messaging services.

Use the Join button to connect two callers by joining the 
active call with the call that is on hold at the Enterprise Edge 
Attendant Console. Refer to Linking and Joining calls on 
page 56.
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Words and colors on Loop buttons:

Use the View Parked button to display the Parked dialog 
box, which lists any parked calls. Calls can be parked and 
retrieved from any Enterprise Edge telephone connected to 
your Enterprise Edge server. Refer to Parking calls and 
paging employees on page 51.

Use the Voice Call to initiate a call from the attendant’s 
telephone to the speaker of another telephone without first 
causing the telephone to ring. Refer to Parking calls and 
paging employees on page 51.

Six Loop buttons, labeled F1 to F6, are on the left side of the 
Attendant window and are used to answer calls. Each Loop 
button represents call. The color of the Loop button and the 
displayed word shows the type of call activity occurring. 

You can display or hide Loop buttons, depending on your 
preference. On the View menu click Hide Loop Buttons. 
When a check mark appears, only active Loop buttons 
appear. When Hide Loop Buttons is not selected, all the Loop 
buttons appear.

The word Ringing appears on a yellow 
Loop button when an incoming call 
rings at the attendant’s extension.

A green Loop button with the word 
Active appears when a call is 
answered by the attendant. Only one 
Loop button is active at one time.

A blue Loop button with the words On 
Hold appears when a call is on hold at 
the attendant’s extension.

An orange Loop button with the word 
Callback appears when a call returns 
to the attendant from the Target 
extension.

A red Loop button with the word 
Ringing appears when a call rings at 
an Assigned extension.

Grey Loop buttons appear when the 
Loop button is inactive and when Hide 
Loop Buttons is not selected.
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Using Caller Information options
Caller Information options are in the top, center of the Attendant window. Calle
Information options contain information about the caller that appears in the bo
when you answer a call.

Caller Information options include:

• Name, Caller Type list boxes (Unclassified, Personal, Employee, Vendor, o
Customer), Company and Note boxes

• Contacts boxes that display the three parties the caller most frequently ca
your company

The following buttons appear in the Caller Information options:

opens the Edit Caller Information dialog box. Refer to 
Maintaining caller information on page 63.

places the active call on Hold.

disconnects the active call.

places the active call in park and opens the Page dialog box 
so that you can page the person whose extension is in the 
Target list box. 
Refer to Parking calls and paging employees on page 51.
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The Edit Caller Information dialog box

Use the Edit Caller Information dialog box to change or add information abou
callers. 

To access the Edit Caller Information dialog box:

1. Below the Caller Information  options, click the Edit button.

The Edit Caller Information dialog box contains the following boxes:

Name list box contains the caller’s name. A first time caller name is the Caller ID 
name provided by the telephone. company. You can change this 
Caller ID name to the actual caller’s name.

Caller Type list box contains the classification of the caller. There are five types to choose 
from: Unclassified, Personal, Employee, Vendor and Customer.

Company box contains the name of the company associated with the caller. The 
Caller ID name is automatically filled in this box. You can edited it 
here or in the Caller Information options.

Phone box contains the caller’s telephone number of the caller.

City, State/Province, 
and ZIP/Postal Code 
boxes

contain the caller’s address.

Caller ID Name and 
Caller ID Number 
boxes

contain information provided through subscription by the public 
switched telephone network.

Record Number box contains a unique caller record identifier number. This box is not 
editable.

Contacts boxes list the caller’s three most frequently called persons in your company.
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 The following buttons appear in the Edit Caller Information dialog box:

Using the call processing area

The call processing area is at the top right of the Attendant window and inclu

• the Target list box

• a series of buttons including: Transfer, Page, VMTransfer, Screen, Call, C
On and Link Transfer.

 
saves the caller record displayed in the boxes of the Edit 
Caller Information dialog box to the database.

closes the Edit Caller Information dialog box without saving 
the changes to the record.

opens the Find dialog box in the Edit Caller Information 
dialog box.

creates a blank caller record that you can add information 
to.

creates a new name caller record using an existing caller 
record. All boxes except the Name box contain the existing 
caller information. You must enter the new name.

deletes caller record displayed in the Edit Caller Information 
dialog box from the database.

Use the Target list box to enter the extension or telephone 
number to call.
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The following buttons are in the call processing area: 

Using the Directory options
The Directory options are at the bottom of the Attendant window. They conta
tabbed directories that show various views of the extensions on your Enterpr
Edge telephone system. The Directory options also contain buttons and boxes fo
searching and editing extension and employee information.

Search and edit functions in the Directory options
The buttons and boxes in the Directory options are used to search for and ed
employee information that appears in the Directory list:.

transfers the active call to the extension number in the Target 
list box.

screens a call transfer of an active call to the extension 
number in the Target list box. Click the Screen button and the 
caller is put on hold. The caller is connected to the Target 
extension when you click Transfer Now in the Screen 
Transfer dialog box.

opens the Page dialog box.

makes a call from the attendant’s extension to the number in 
the Target list box.

transfers the active call to the voice message mailbox of the 
extension in the Target list box so the caller can leave a 
message.

places a call on hold at the target extension.

accesses Centrex/CO line features (such as off-premise 
transfer or conference) or other systems or carriers while on 
an outside call. It is also used to tone dial the digits in the 
Target list box.

indicates the status of the employee. When 
you select a category from the list box, a 
corresponding icon appears in the first 
column of the Directory list. The available 
category are: None, Not at Desk and Out of 
Office.

used to enter information about individual 
employees.
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changes the caller/Caller ID record to an 
employee record if an employee calls in from 
outside. This prevents an employee name 
from appearing in the caller record related to 
the Caller ID name/number.

finds names of individual employees or 
groups of employees by department. The Find 
box finds employee by name. The 
Department box is finds employees by 
department. Type the first few letters of the 
name in the Find box and click the Find 
button. Names that start with the letters 
appear in the Directory list. To search by 
department, select a department from the 
Department list box and then click the Find 
button. Employees in the selected department 
appear in the Directory list.

resets the Full tab Directory view to display all 
names and extensions.

opens the Edit Employee Information dialog 
box. If you select a name or extension in the 
Directory list, information about to that name 
or extension appears in the dialog box. If you 
do not select a name or extension, the Edit 
Employee Information dialog box is empty. 
You can also access the Edit Employee 
Information window by clicking the Edit menu 
and clicking Employee Information. Refer to 
The Edit Employee Information dialog box on 
page 40 and Maintaining employee 
information on page 67.
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The Edit Employee Information dialog box

This dialog box appears when you click the Edit  button in the Directory option. 
Use the Edit Employee dialog box to change or add information about employ
For further information, refer to Maintaining employee information on page 67.

The Edit Employee Information dialog box contains the following boxes that a
editable unless indicated otherwise:

Name list box contains the employee’s name or the extension number if a name is 
not entered.

Type list box contains the classification of the employee record. “Employee” is the 
default.

Department box contains the name of the department associated with the employee.

Phone box contains the employee’s telephone number. The Phone box is not 
editable.

City box contains the employee’s city.

State/Province box displays the state or province of the employee.

ZIP/Postal Code box displays the ZIP code or Postal Code of the employee.

Assistant Extension box displays the extension of the person who handles calls for the 
extension when the employee cannot.

Record Number box displays a unique record identifier number. The Record Number box 
is not editable.
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The following buttons appear in the Edit Employee Information dialog box:

Directory list

Directory list tab views

There are four Directory list views that are accessed by clicking tabs. They ar

Voice Mail box displays the voice message mailbox extension of the employee. 
Voice Mail Box is not editable.

Contacts boxes lists the employee’s three most frequently called persons/extensions 
in the Company.

saves the employee information displayed to the database.

closes the window without saving the record.

opens the Find dialog box in the Edit Employee Information 
dialog box. Refer to Maintaining employee information on 
page 67.

creates a new name for the extension and leaves all other 
boxes unchanged.

Full displays extensions connected to the Enterprise Edge server, including 
wireless Companion telephones, Enterprise Edge Voice Messaging 
extensions and Hunt group extensions. This view displays the 
maximum amount of extension and employee information allowed in 
the Directory list.

Name list box contains the employee’s name or the extension number if a name is 
not entered.
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Directory list employee and extension information

Each one of the Directory list tab views contains the following types of employe
and extension information.

Note: The first two columns are not labeled and contain icons only, no text.

BLF displays extensions connected to the Enterprise Edge server, including 
wireless Companion telephones, Enterprise Edge Voice Messaging 
extensions and Hunt group extensions. This view displays only the 
person status icon, telephone status icon and employee name. This 
allows more extensions to be displayed at once.

Assigned displays specific extensions for which an assistant attendant is 
responsible. Like the Full tab view, the Assigned tab view displays the 
maximum amount of extension and employee information allowed in 
the Directory list. Extensions are assigned or removed from the 
Assigned tab view in the Options dialog box. Refer to Assistant 
attendant setup on page 20.

Selected displays a subset of the Full tab extensions. The Selected tab view 
displays the maximum amount of extension and employee 
information allowed in the Directory list. Selected extensions are 
particularly useful if the attendant directs incoming calls to a limited 
number of extensions and wants to display only those extensions. 
Extensions are added or removed from the Selected tab in the 
Options dialog box.

person status icon This is the leftmost column in the Directory list views and does 
not have a column heading. It can contain an icon or be 
blank. The person status icon shows the physical location of 
the employee. Refer to Search and edit functions in the 
Directory options on page 38.

telephone status icon This is the second column from the left in the Directory list 
views and does not have a column heading. The telephone 
icons show the current status of the telephones connected to 
the Enterprise Edge Server. They also show additional 
information such as whether the extension is ready to receive 
calls or is on Do Not Disturb (DND). The telephone icons are:

Available for 
calls

Do Not 
Disturb

Call 
Forwarded

On-hook

Off-hook

Note:A Hunt Group is a group of telephones that can all be 
called by a single number. Hunt Groups are configured in 
your Enterprise Edge server. The telephone status icon for a 
Hunt Group extension is blue and always indicates on-hook.
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The remainder of the columns in the Directory list are labeled as follows:

Sorting information in the Directory list tabs

Extension and employee information contained in the Directory list tabs can be 
sorted in different ways. In the Full, Assigned and Selected views, the information 
appears in columns with headings.

To sort alphabetically by Name, Notes or Department:

1. In the Directory  list, click either the Name, Notes or Department column 
heading. The information sorts alphabetically by the column you select.

To sort numerically by extension:

1. In the Directory  list, click the Ext column heading. The information sorts 
numerically by extension.

Name the first labeled column on the left, containing the names of 
employees.

Ext contains telephone extensions.

Notes displays additional information about the employee that the 
attendant enters. Notes can be edited only from the Notes list 
box at the top of the Directory dialog box.

Department displays the name of the department to which the employee 
belongs. Enter the department by clicking the Edit button, 
clicking Employee Information and using the Edit Employee 
Information dialog box. Refer to Maintaining employee 
information on page 67.
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Handling calls

With Enterprise Edge Attendant Console, you can manage calls using either 
PC’s mouse or the keyboard. When a call comes in, you can respond to the c
using either the telephone or a headset.

Note: You can use a headset so that your hands are free to use your PC.

The basic steps in processing an incoming call with Enterprise Edge Attenda
Console include:

• answering a call. Refer to Answering calls as an attendant on page 45.

• finding the called person’s extension and placing it in the Target list box. R
to Finding the called person’s extension and placing it in the Target list box on 
page 47.

• transferring a call. Refer to Transferring a call on page 49.

Other telephone functions include:

• parking the incoming call and paging the employee. Refer to Parking, holding 
and screening calls on page 51.

• linking and joining calls. Refer to Linking and Joining calls on page 56.

• handling a callback call. Refer to Handling a callback call on page 57.

• making a call from the attendant’s extension. Refer to Making a call from the 
attendant’s extension on page 59.

• managing calls at the employee’s telephone. Refer to Managing calls at the 
employee’s telephone on page 60.

The following steps explain how you handle calls as an attendant using the 
Attendant window. For further information about and a diagram of the Attenda
window, refer to Components of the Attendant window on page 25.

Answering calls as an attendant
The Attendant window has six Loop buttons that are used to answer calls.

Each Loop button can handle a single call in progress. The color of the Loop b
changes depending on the activity. You can show or hide inactive Loop button
clicking Hide Loop Buttons on the View menu. If they are hidden, the Loop 
buttons appear only when a call occurs. When the Loop Overflow icon appears on 
the Status Bar there are more calls that the six indicated by the Loop buttons.

5
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A new incoming call appears as yellow Loop button that displays the word Ring
Information about the call appears beside the Loop button to assist you with 
personalized call processing:

• the function key name above the Loop button, (F1 in the example) shows
key on the PC keyboard that relates to the ringing Loop button.

• the timer above the Loop button shows in minutes and seconds how long th
call is active.

• the company name to the right of the Loop button, shows the company th
calling. The company name is either from the caller database or, if the cal
new, from the Caller ID name provided by the telephone company. If you 
not subscribe to Caller ID service, this line of display is blank. You can en
or edit a company name using the Caller Information list box.

• The Caller ID name on the second line of the information to the right of th
Loop button, shows the Caller ID number provided by the telephone comp
If you do not subscribe to Caller ID service, this line of display is blank.

• The bottom line of information to the right of the Loop button displays the 
name of the Enterprise Edge server line that carries the call.

Note: Server line names are programmed in your Enterprise Edge server by
telephone administrator.

Note: If your Enterprise Edge server is shared by two or more companies, th
telephone administrator can associate the names of each company with
hardware lines. This means that you can tell which company is being ca
before answering the call.

To answer an incoming call:

1. A Loop button turns yellow and the label changes to Ringing. You can resp
to a call one of four ways:

• Click the yellow Ringing Loop button.

• Press the function key on the PC keyboard (for example, F1) shown above 
the Loop button.

• Press the Esc key.

• Press the associated intercom or line key on your telephone.

The Loop button becomes green and displays the word Active.
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2. Answer the call with your company greeting and determine from the calle
whom they wish to speak. If you are answering a call from this number or
company for the first time, you can enter caller information. For further 
information, refer to The Edit Caller Information dialog box on page 36. If you 
are not, refer to Finding the called person’s extension and placing it in the 
Target list box on page 47.

To release or hang up a call:

1. Click the Release button.
The call disconnects and the Loop button becomes idle.

Finding the called person’s extension and placing it in the Target list box
After you answer a call, find and click the called extension to put it in the Targe
box.

There are four ways to locate the correct extension when you are ready to pro
call, including:

• Using the Contacts boxes on page 47

• Using the Directory tab views on page 48

• Using the Directory Find box on page 48

• Using the Department list box on page 49

Using the Contacts boxes
The Contacts boxes contain the extension numbers and names of the three m
frequently called parties that the caller requests. These caller contacts are lis
from most frequently to least frequently called.

To the left of each Contact box is the current person status icon for that contac
to the right of each Contact box is that person’s telephone status icon.

To transfer a caller to one of the three most frequently called parties:

1. Double-click the telephone status icon.
The call is forwarded to that extension.
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Using the Directory tab views
The tab views in the Directory dialog box contains various views of extension

To search by Extension or Name:

1. Click the Full , BLF, Assigned or Selected tab.

2. Click the extension, the name or the department of the employee being c
in the list. The name or extension number now appears in the Target list b

3. Click the Transfer button.

Using the Directory Find box
Use the Directory Find box to search by name.

To search by Name and move the target extension to the Target list box:

1. In the Find box, type the first letter or letters of the person’s last name or fi
name, depending on how the employee names are entered. For example, 
are entered “Jane Doe”, type “j”. If they are entered “Doe, Jane”, type “d”.

2. Click the Find button.
Any matching names are displayed in a list under the Full tab.

3. In the Directory  list, click the name of the employee being called.
The name now appears in the Target list box.

4. To restore all names in the Full tab view, click the Show All button.

After the search result is shown in the Full tab view, the BLF, Selected and 
Assigned tab views remain unchanged.
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Using the Department list box
You can search for a name by department from the Full tab using the Depart
list box.

To search by department:

1. Click the arrow of the Department list box.
A list of departments associated with extensions appears in the list.

Note: Department names for each extension are created in the Edit Employee 
Information dialog box.

2. Click a department name from the list and the department name appears 
Department box.

3. Click the Find button.
All extensions that match the department appear in a list under the Full 
Directory tab view.

4. In the Directory  list box, click the name of the employee being called.
The name appears in the Target list box.

5. After the search result is shown in the Full tab view, the BLF, Selected an
Assigned tab views remain unchanged. To restore all names in the Full ta
view, click the Show All button.

Transferring a call
You can transfer an active call to an extension using the Contacts box, the Ta
list box or the Directory dialog box. You can also transfer a call to a voice mes
mailbox.
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To transfer using the Contacts box:

1. Double-click the telephone status icon to the right of the Contacts box.
The call transfers to the displayed extension.

To transfer using the Target list box:

1. Make sure the extension in the Target list box is correct. Double-click the 
telephone status icon to the right of the Target list box or click the Transfer 
button. You can also click the Target list box and press the Enter key on the 
keyboard.
The call transfers to the displayed extension.

To transfer using the Directory list:

1. Scroll through the Directory list. Double-click the telephone status icon or
name of the person to whom you are transferring the call.
The call transfers.

To transfer a call to the voice message mailbox of the extension in the Targe
box:

1. Type the extension number of the employee in the Target list box.

2. Click the VMTransfer  button.
The caller transfers and the Loop button becomes idle.

Note: You can make the VMTransfer button inactive when a non-Enterprise
Edge Voice Messaging system is attached to the Enterprise Edge 
server.
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To transfer a call to an outside number:

1. With an active incoming call on Enterprise Edge Attendant Console, in the
Target list box type an outside telephone number.

2. Click the Link Transfer  button.
The Loop button label shows Active, and the number in the Target list box
tone dialed.

3. Click the Release button and the incoming call transfers to the outside 
telephone number.
The Attendant disconnects from the call and the Loop button becomes idl

Parking, holding and screening calls
Enterprise Edge Attendant Console lets you screen calls for the called person,
the calls on hold and park calls so that you can page the called person. You ca
talk to the employee in intercom mode using Voice Call.

Parking calls and paging employees
The Park/Page feature lets you place a call on Hold and page the employee. Y
also use this method to page an employee when there is no active call.

To park a call and page an employee:

1. In the Target list box type the extension number of the called person.
If there is no active call and you want to page an employee, type or select
extension of the person being paged in the Target list box.

2. Click the Park/Page button.
The Page dialog box appears. The Page dialog box shows all parked call
all page zones so that the called person can be paged.
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3. Click a call in the Parked calls list and then click the appropriate zone in the
Page zones list.

4. Click the Page button.
The Console Message box appears and the speakers on the telephones in t
selected zone emit a low-level audible tone.

5. Speak into the headset or handset, depending on your setup. When you a
finished, click the OK  button.
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To retrieve a parked call:

1. On the Caller menu, click View Parked Calls.
The Parked Calls dialog box appears.

2. In the Parked Calls list click the parked call.

3. Click the Retrieve button.

or

1. On the toolbar, click .

2. In the Parked Calls list select the parked call.

3. Click the Retrieve button.

To view all parked calls that are still in park:

1. On the Caller menu, click View Parked Calls. 
The Parked Calls dialog box appears and lists all parked calls and:

• the park number of the call

• the caller’s name (from the Name box of the Caller Information list box

• the name or extension of the called employee

2. Click the Close button.
The Parked Calls dialog box closes.
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Placing and retrieving calls on hold
Calls can be placed on Hold and retrieved quickly.

To put an incoming call on hold:

1. Click the Ringing Loop button.

2. Click the Hold button or click another Ringing Loop button.
The previous call is put on hold.
When the active call is placed on hold, the Loop button label changes to H
and the Loop button color changes to blue.

To place a call on Hold at an active extension:

1. With an active call on the Loop button and the employee’s extension in th
Target list box, click the Camp On button.
When the active call is camped on the Target list box extension (placed on
at the Target extension), the Loop button becomes idle.

2. The camped call sends a message with tones to the employee either on or
telephone, indicating a call is camped on their extension.

To retrieve a call on Hold:

1. Click the blue Loop button labeled On Hold.
The Caller Information boxes show all of the information related to this ca

2. Respond to the call accordingly.
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Screening calls
You can screen calls by talking with the employee and asking whether they wa
talk to the caller.

To screen/transfer a call:

1. Click the Screen button.
The active call goes on hold. The Loop button changes color to blue. The 
extension rings and the Screened Transfer dialog box appears.

2. Ask the person being called if they can take the call. If the answer is yes c
the Transfer Now button and the call transfers. If the answer is no follow ste
3 to 5.

3. Click the Cancel button.

4. Click the Loop button on which the call is being held to reconnect with the
caller.

5. Process the call accordingly.

Contacting employees using Voice Call
You can use this feature as an intercom to talk directly through the speaker o
employee’s telephone.

To use the Voice Call button:

1. In the Target list box type or enter the extension of the employee.

2. On the toolbar, click .

3. Speak to the employee through the speaker in their telephone.
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Linking and Joining calls
Using Enterprise Edge Attendant Console, you can link calls to create confer
calls or have callers join existing calls to also create conference calls.

Note: Use the DTMF button to transfer or link calls on Centrex lines.

To use the DTMF button with an active incoming call on a Loop button:

1. On the toolbar click .
The active incoming call is placed on hold. 

2. In the Target list box type an outside telephone number.

3. On the toolbar click .
The number in the Target list box is dialed out with DTMF tones on the sa
CO line on which the active incoming call arrived.

4. Click the Release button and the incoming call transfers to the outside 
telephone number (using the telephone company’s Centrex capability). Th
Attendant disconnects from the call and the Loop button becomes idle.

To Join a call on hold on a Loop button with an active call on another Loop bu

1. On the toolbar click  .

2. Drag the “Join” cursor to the Loop button on which the call is held. 

3. Click the Loop button holding the call.
The two callers connect, the Attendant releases from the active call and b
Loop buttons become idle.

To create a conference call to an outside number:

1. With an active incoming call on Enterprise Edge Attendant Console, in the
Target list box type an outside telephone number.

2. Click the Link Transfer  button.
The Loop button label shows Active, and the number in the Target list box is 
tone dialed.

3. Click the Link  button to set up a conference call between the incoming call,
outgoing call and the Attendant.

When the conference call is finished, click the Release button to disconnect from 
the call.

Note: To disable the Link Transfer button, on the Tools menu click Options. The 
Options dialog box appears. Select Disable Link Transfer Option.
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Handling a callback call
There are two types of calls that return to Enterprise Edge Attendant Console

• a call that is not answered at the extension to which it was transferred

• a call that the called person returns to you for attendant handling

Responding to a callback that an extension did not answer
A callback can be a call that is sent to an extension, or a call that is not answ
and returns to you.

The callback is indicated by:

The Callback button displays the name and extension from which the call is 
returned and other call related information. This allows you to personalize how
handle the call.

To respond to a Callback call:

1. Click the Callback button.

The Caller Information list box shows the information originally displayed so t
you can process the call accordingly, such as transfer to Enterprise Edge Vo
Messaging, park the call, page the called person, and so on.

Responding to a callback that a called party returned
A call that the called person elects not to take can be handled by you accordi
instructions that you or your company establish. This type of call is similar to 
Callback to the attendant. The called person can use the buttons below the d
area of the telephone to communicate to you, the attendant, how to handle th
with one of the following messages:

• Hold. You ask the caller to hold for a moment.

• Assist. You send the caller to the called party’s assistant.

• IntAct. You inform the caller that the person they called is on the line and
if they wish to interrupt the call.

The display button the employee presses sends a pre-set message to you. E
Hold, Assistant or Interact is displayed below the Callback button.
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To respond to a Callback call that a called party returned:

1. Click the Callback button.
The Caller Information list box shows the information originally displayed.

2. Advise the caller according to the pre-set message that appears.

To process a hold call:

1. Advise the caller that the employee requests that they hold.

2. In the Target list box enter the employee’s extension.

3. Click the Camp On button.
The call is camped to the called employee’s extension.

To process an assistant call:

1. Tell the caller that the employee is temporarily unable to take calls and req
that calls are routed to the Assistant extension.

2. Click the Edit  menu and then click Employee Information .
The Employee Information dialog box appears and the assistant’s numbe
appears in the Assistant Extension box.

3. Click the Close button to return to the Attendant window.

4. In the Target list box enter the assistant’s extension number.

5. Transfer the call to the assistant’s extension number.

To process an interact call:

1. Tell the caller that the employee is on another call but can be interrupted.

2. If the caller agrees, enter the employee’s extension in the Target list box.

3. Transfer the call back to the extension.
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Making a call from the attendant’s extension
As the attendant, you can call any extension in the company and any outside
number. The telephone number you type in the Target list box does not requi
special characters such as a hyphen, a parenthesis, a blank space or a comm
(special characters are ignored). However, to reach special services such as
Interactive Voice Response systems (IVR) you can type special characters (*,
and W) in the Target list box and these characters can be dialed using  o
toolbar.

To place a call to an extension or outside number:

1. When there is no active call, type or select an extension or outside numbe
the Target list box.

2. Press Enter on the keyboard.
A call is made to the extension/outside number.

To transfer a call to an extension:

1. Place or type an extension in the Target list box when there is an active call.

2. Press Enter on the keyboard.
The call transfers to the extension.

If you select an entry in the Directory or in the Contacts box, the extension num
also appears in the Target list box. If the Target is an extension, the Person S
icon for the person appears to the left of the Target list box. To the right of the
Target the person’s telephone status icon appears.

To make a call to an inside extension:

1. Make sure that the number you want to call appears in the Target list box. You 
can type the extension in directly or select it from the Directory list.
For further information, refer to Using the Directory Find box on page 48.

2. Click the Call button or press the Enter key to make the call.

To make a call to an outside number:

1. In the Target list box type the same digits you dial if you were using your 
Enterprise Edge telephone.

2. Click the Call button or press the Enter key.
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Managing calls at the employee’s telephone
Enterprise Edge Attendant Console has features that let employees manage 
calls from their telephones.

After a call is routed to an extension, a low-level audible tone alerts the called
person they have an incoming call, even if they are on their telephone. The na
the caller appears in the display area of the called party’s telephone for a few
seconds.

The called person has six options for managing the call using the three displa
buttons below the display area of the Enterprise Edge telephone. These optio

• talk to the caller 

• put the call on hold 

• send the call to Enterprise Edge Voice Messaging

• join the call with the current call 

• send the call back to the attendant to ask the caller if they wish to interrup
current call 

• send the call back to the attendant to be routed to an assistant attendant 

Note: Press the Next display button to see more than the first two options that
appear.

To talk to the caller:

1. Press the Talk display button to automatically connect with the call, or pick u
the handset.

If the telephone is in use, press the Talk display button to put the first call on hold
and connect the new caller.

To send the caller to the attendant who asks the caller to hold:

1. Press the Hold display button
This delivers a pre-set message to the attendant. The attendant asks the c
hold for the called person and camps the call to the called person’s extens

2. The called person sees the call camped on their telephone and handles t
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To send the caller to Enterprise Edge Voice Messaging:

1. Press the VM display button on the telephone.
The call automatically transfers to the called person’s voice message mai

To join the caller with another call:

1. Press the Join display button to conference the caller in with your current 
call.
The called person can see the caller’s name or Caller ID name in the disp
area of the Enterprise Edge telephone and decide whether to join the call
with the current call.

To send the call to the attendant who asks the caller if they want to interrupt:

1. Press the IntAct display button. This delivers a pre-set message to the 
attendant who asks the caller if they want to interrupt the employee.

2. If yes, the attendant transfers the call back to the employee.

3. The calling party’s name appears in the Enterprise Edge telephone display
of the called person’s telephone for approximately 20 seconds. To pick up
call that the attendant transfers back, press the Talk display button.

To send the caller to an Assistant extension:

1. Press the Assist display button. This delivers a pre-set message to the 
attendant. The attendant tells the caller that the called person is temporar
unable to take calls and requests that they are transferred to an Assistant
extension.

2. The attendant refers to the Assistant extension box in the Edit Employee 
Information  dialog box and enters the Assistant extension number in the 
Target list box.

3. The attendant transfers the call to the Assistant extension.
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Maintaining caller and employee 
information

Enterprise Edge Attendant Console manages both caller and employee inform

Maintaining caller information
When your company is called, information about the caller from the Enterpris
Edge Attendant Console database appears in the Caller Information list box o
Attendant window. You can decide to enter information for an incoming call 
depending on whether the caller is calling for the first time or has called previo
and already exists in the database.

Creating a new caller record
New caller records are created in the following ways:

• automatically, during an active call, the first time Caller ID information is 
received by the Attendant component. You can customize the new caller 
record during the active call or later.

Note:The caller record is not saved if you click the Release button without
processing the call.

• when you create a new caller record from an existing one

• when you create a new blank caller record

When a call comes in, Enterprise Edge Attendant Console checks the Caller 
from the telephone company to see if the number has previously called. If the
a record that the number has called before, information from the caller databa
appears in the Caller Information list box on the Attendant window. The Name
box displays the names of callers on record that are associated with the inco
Caller ID. There can be several callers from the same telephone number call
they are employees at the same company. For more information, refer to The Edit 
Caller Information dialog box on page 36.

If you select the name of the caller from the list, the Caller Information list box 
displays information about the caller.

6
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To create a new caller record from an active call:

1. Click the Ringing Loop button to answer the incoming call.
Information in the database about the caller appears in the Caller Informa
list box on the Attendant window.

2. In the Caller Information  list box click Edit .
The Edit Caller Information dialog box appears.

3. Click the New Caller button.
This clears all the boxes in the Edit Caller Information dialog box and allows 
you to create a new caller record.

4. In the Name list box, type the caller’s name in the format of last name first,
space, then first name.

5. From the Caller Type list box, select a Caller Type, either Unclassified, 
Personal, Employee, Vendor or Customer.

6. In the Company box, type the caller’s company’s name.

7. Click the Save button to save the information.
If you click the Close button without saving, the message, “Do you want to 
save the current record?” appears. Click the Yes button to save the record.

8. After you enter caller information, process the call by:

• transferring the call to the called party. Refer to 
Transferring a call on page 49.

• placing the call on hold. Refer to Parking, holding and screening calls on 
page 51.
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• transferring the call to Enterprise Edge Voice Messaging. Refer to 
Transferring a call on page 49.

• parking the call and paging the called party. Refer to Parking calls and 
paging employees on page 51.

To create a new name caller record from an existing caller record:

1. On the Attendant window, in the Caller Information  options, click the Edit  
button.
The Edit Caller Information dialog box appears.

2. Click the New Caller button.
This clears only the Name box in the Edit Caller Information dialog box an
leaves all other boxes unchanged.

3. In the Name list box type the new caller’s name.

4. Click the Save button when you are done to save the record.

To create a new caller record when there are no active calls:

1. On the Attendant window, in the Caller Information  options, click the Edit  
button.
The Edit Caller Information dialog box appears.

2. Click the New Caller button.
A new blank caller record is created with a new Record Number assigned

3. Type the desired information in the boxes.

4. Press the Save button to save the new caller record.

To create a new caller record associated with an existing Caller ID when ther
no active calls:

1. On the Attendant window, in the Caller Information  options, click the Edit  
button.
The Edit Caller Information dialog box appears.

2. Click the Find button. 
The Find dialog box appears.
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3. In the Name box type the name of another caller from the same company 
click the OK button.

4. Click New Name and the Name box is cleared. The other boxes are unaltere

5. Type the new caller’s name.

6. Click the Save button.
The record is now saved in the database.

7. Click the Close button.

Note: If you click the Close button without first clicking the Save button, the E 
Caller Information dialog box closes without saving any changes.

Finding and editing caller information
You can edit caller information at any time and save the changes.

To find caller information:

1. In the Attendant window, in the Caller Information  options, click the Edit  
button.
The Edit Caller Information dialog box appears.

2. Click the Find button.
The Find dialog box appears. Use the Find dialog box to find a caller’s nam
the database.

3. In the Name box, type the first letter or letters of the caller’s last name.

Note: If the caller’s first name is used instead of their last name, type the 
letter or letters of the caller’s first name.

4. Click the OK  button or press the Enter key.
The Find dialog box closes.

5. Any matching names appear in the Name list box of the Edit Caller 
Information  dialog box.
If there is more than one name, a list appears below the Name box.

6. Click the caller name you want to edit.
The information about the caller appears in the Edit Caller Information dia
box.
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To edit a caller’s record:

1. Make sure the caller name you want to edit appears in the Edit Caller 
Information dialog box. Click the box you want to edit and make the chan
Repeat if needed.

2. Click the Save button to save the changes to the database.

3. Click the Close button to close the Edit Caller Information dialog box.

Note:If you answer a call and then open the Edit Caller Information dialog b
without first selecting a name from the Name box list, you must click 
Edit  button twice.

To delete an existing caller record:

1. In the Attendant window, in the Caller Information  options, click the Edit  
button.
The Edit Caller Information dialog box appears.

2. Make sure the caller name you want to delete appears.

3. Click the Delete Caller button.
The record that appears in the Edit Caller Information dialog box is deleted from 
the database.

Maintaining employee information
When Enterprise Edge Attendant Console is installed, employee information 
extracted by the Enterprise Edge server. This information appears in the Dire 
list box in the bottom center of the Attendant window.

The Directory list box has four different tabs that display lists of employees. Th
are Full, BLF (Busy Lamp Field), Assigned and Selected. For further informat
refer to Search and edit functions in the Directory options on page 38.
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Working with the Directory list
Information in the Directory list appears in ascending order (for example, 1 to
A to Z), and sorting is based on the contents of only one column at a time. If t
are different forms of information in the same columns, priority is given in the
following order: no information entered (blank), numeric then alphabetic. For 
example, if you sort a Name column that contains both names and extension
numbers, the extension numbers appear before the names.

You can sort Directory information by column by clicking any column heading. 
example, to sort the directory by extension, click the Ext column heading. The
listing appears with the extensions in numerical order. 

To sort a column of information in the Directory:

1. Click the tab for the view you want to sort, either Full , Selected or Assigned. 
Information in the BLF tab view appears in the same order you select for F
view.

2. Click the column heading you want to sort, either Name, Ext, Notes or 
Department. 

Finding an employee record
You can search for an employee by name, by department or by an individual w
a department.

You can search by an employee’s name two different ways:

• on the Edit Employee Information dialog box click the Edit button and then
click the Find button 

• on the Attendant window, in the Directory list box, click the Find button
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To search by name:

1. In the Attendant window, in the Directory  options, click the Edit  button.
The Edit Employee Information dialog box appears. For more information, 
refer to The Edit Employee Information dialog box on page 40.

2. Click the Find button.
The Find dialog box appears.

3. In the Name box, type the first letter or letters of the employee’s last name

Note: If the employee’s first name is used instead of their last name, type
first letter or letters of the employee’s first name.

4. Click the OK button or press the Enter key.
The Find dialog box closes. Any matching names appear in the Name box
the Edit Employee Information dialog box.

To search by name on any Directory list box on the Attendant window:

1. In the Find box on the Attendant window type the first letter(s) of the perso
last or first name, according to how names are listed in the Directory list’s
Name column.

2. Click the Find button.
Any names that match the letter(s) you enter appear in a list in the Full tab 
Directory view.

To search by department:

Note: A department search takes priority over a name search.

1. In the Directory  options, click the arrow of the Department list box.
A list of departments that are associated with extensions appear in the list
name of the department for each extension appears in the Edit Employee
Information dialog box.

2. Click the department name from the list and the department name appears
Department box.

3. Click the Find button.
Any extensions that match the department appear in a list in the Full tab 
Directory view.
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To search for an individual in a department:

1. From the Department box select a department.

2. In the Find box type the person’s name.

3. Click the Find button.
Any extensions that match the name in the department appear in a list in 
Full tab Directory view.

Resetting the Full tab view

You can reset the Full tab view to the default display.

To reset the Full tab view:

1. In the Directory  options, click the Show All button.
The Full tab view appears with extension, names, notes and department 
information. 

2. Click the Show All button to return to the Directory view after you perform 
search.

Editing employee information
You can edit employee information by adding or changing an extension, chan
the person status of an extension or by creating a new name for an extension

To add or change an extension:

1. In any Directory tab view (Full, BLF, Selected or Assigned), click the 
extension in the Directory  list for which you wish to change or add 
information.

2. In the Directory options, click the Edit  button.
The Edit Employee Information dialog box appears. Use this dialog box to
create or edit information in the employee database.

3. Click any editable box and type the new information.

4. Click the Save button to save the changes to the database and to automat
apply the changes to the employee’s extension in the Directory.

5. Click the Close button to close the Edit Employee Information dialog box.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01



Maintaining caller and employee information  71

f the 

’s 
n 

’s 

d as a 
To change the Person status of an extension:

1. In any of the Directory views (Full, BLF, Assigned or Selected), click the 
extension.

2. From the Status list box select None, Not at desk or Out of office.
The status you choose appears as an icon in the Directory view to the left o
extension Name.

There is no icon for None. Instead, a blank space appears next to the person
telephone status if you select it. If you select Out of office the Out of office ico
appears . If you select Not at desk the Not at desk icon appears  .

Do not type in the Status box.

Creating a new name for an extension

You can change the name of an employee assigned to an extension.

To create a new name for an extension:

1. In the Directory options, click the Edit button.
The Edit Employee Information dialog box appears.

2. Click the New Name button.

3. Type the new employee’s name.

4. Click the Save button when you are done.

Using the Make Caller button

Use this function if an employee calls from a customer’s office.

To assign the name of an employee to a caller record:

1. In the Directory list, select the employee's extension or type the employee
extension number in the Target list box.

2. Click the Make Caller button.
The name of the employee is assigned to the caller record and is not save
customer record.
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Adding notes to employee records

You can add a note to an employee record by selecting a note from a list or t
a personal note. The note appears in the Notes column under Directory in the
Attendant window.

To select from the list of notes:

1. Click an extension number in the Full , Assigned or Selected Directory  views.

2. From the Note list box, click the applicable note.
The note appears in the Directory list’s Notes column.

To type a note:

1. Click an extension number in the Full , Assigned or Selected Directory  views.

2. In the Note list box type a note.

3. Press the Enter key.
The note appears in the Directory list’s Notes column.

Note: To delete a Note, delete the information in the Note list box and then 
press the Enter key.
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To save employee edit changes:

1. In the Edit Employee Information dialog box click the Save button.
The changes made to the boxes in the Edit Employee Information dialog b
for the employee highlighted in the Directory list are saved to the databas
After you click the Save button, the Edit Employee Information dialog box
remains open.

To close the Edit Employee Information dialog box without saving changes:

1. Click the Close button.
The Edit Employee Information dialog box closes.

Note: If you click the Close button without first clicking the Save button, the Edit 
Employee Information dialog box closes without saving any changes.
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Generating reports

Enterprise Edge Attendant Console automatically collects information about 
incoming calls and tracks how calls are processed. Use the information from 
Reports component to help spot trends and prevent problems.

You can use the caller-related information in Reports to:

• increase sales opportunities

• improve productivity

• lower expenses

• streamline operations

For example, the report Calls by Customer shows how callers from your compa
top customers are handled. It shows if calls are handled by employees or are 
to Enterprise Edge Voice Messaging.

Report types
There are three report types:

• Calls by Customers

• Calls to Employees

• Extension Directory

Calls by Customers report
The Calls by Customers report shows how your employees handle calls from
customers. Each employee report can identify as many customers as necessa
Calls by Customers report shows:

• the number of calls taken by the employee

• the number of calls routed to Enterprise Edge Voice Messaging

• the number of calls handled by others

• the total calls from each customer

Calls to Employees report
The Calls to Employee report shows the type of calls employees receive ove
defined time period. This report can spot caller abuse, such as too many pers
calls, and misdirected calls, such as calls from customers routed to the wrong p
or department. This report lists the type of call across the top and employees 
the left side. Each Caller Type has a column for number of calls and percent.
total of all calls and percent is shown separately.

7
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Extension Directory report
The Extension Directory report lists the employees who are in the Enterprise 
Attendant Console database and the information in their call record.

Working with the Reports window
To open the Reports window:

1. On the Attendant window click Tools and then click Reports.
The Reports window opens.

The Reports window contains the Database, Information, Period, Employees a
Customers list boxes and a report viewing area. The Reports window menus
File, Edit, View and Help.

Use the Create Report, Page <, Page > and Print buttons to define the type of
you create. You can manipulate the preview image after you create a report.

Database box
The Database box contains information on selecting a database.

Information list box
The Information list box contains the report type information. 

Click the Select button to open the Open dialog box from 
which you can select a Microsoft Access database. For more 
information about databases and how to locate the database 
(.mdb) file, refer to Loading the database on page 79.

Type the path name of a Microsoft Access database in the 
Current Database box.

The Report Type is active and available if you set a 
valid Microsoft Access database in the Current 
Database box.

If you select a report type, a description of the 
report type appears in the Description area.
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Period list box
Note: The Period list box is active if:

• you select a valid database

and

• you select a Report Type requires you to define a Report Period.

opens the One Week dialog box from which you can specify 
a report period with a duration of one week (Sunday through 
Saturday).

opens the One Month dialog box. This dialog box lets you 
select a one-month Report Period.

shows the date of the beginning of the report period. The 
boxes change to reflect dates set by other controls such as the 
Month, Week, and Calendar buttons. The dates in the boxes 
are checked to ensure that the From date is earlier than or the 
same as the To date. If this rule is broken, an error message 
appears.

opens the Calendar dialog boxes that you use to set the From 
and To Report Period Dates. The Calendar dialog box 
resembles the Calendar dialogs boxes in other Windows-
based programs. The Calendar buttons are active if you 
select a valid database and you select a Report Type that 
requires you to define a Report Period.
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Employees and Customers options
Use these options to define customers or employees to generate a report for

The Employees and Customer options contain

Note: The All and Select options for Employees or Customers are available 
if you select a valid database, if you select the report period, and if you s
a Report Type that uses the category Employees or Customers.

Customers and Employees Selection dialog box

From the Customer and Employee Selection dialog boxes, you can choose whic
Employees or Customers to include in a report.

The program records which items were selected in this dialog box the last time
created a report. When the dialog box opens, any items that were selected las
appear as selected. In this way, you can modify the list of selected items.

generates a report that includes data for members of the selected 
category (Employees or Customers).

generates a report that includes data for the members in the list 
box. If you click the Select option, the button under the selection 
list box (labeled either Customer or Employee) becomes available 
so you can make your selection.

list box displays information if you select a subset of the customers and 
employees in your database. If you choose All, the list box is 
blank. The list box cannot be directly edited. If the selected list is 
long enough, you can scroll to view its contents. Use the buttons 
under the list box to change the contents of the list.

Customer/Employee 
option

access directories. The Employee and Customer options are 
active if you choose the Select option. Click these options to 
display either the Employee or Customer Record Selection dialog 
box, from which you can make your selection.
Note:These options are available only if you choose a valid 
database, if you have select a Report Period (if required), if you 
select a Report Type that involves either Employees or Customers, 
and if you choose the Select option for the category.
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Creating and viewing reports
Use the Reports component to generate quality reports for analyzing telephon
at your organization. The following section provides the steps required to gen
reports, including:

• selecting the database

• selecting a report type 

• setting the report period

• selecting employees and customers

• creating and previewing the report

• printing the report

Loading the database
Enterprise Edge Attendant Console stores information about telephone use in
organization in a special database. This database is used to generate the diff
types of reports. In most cases you use the database installed on the Enterpris
server system. However, if you make backups of the database for archiving 
purposes, Reports can use these backups as well. If you are generating repor
a PC that does not have the database stored, locate the database on the ser
through Network Neighborhood. Check with the System Administrator to ens
that the database is a shared file.

To load the database:

1. On the Reports window, at the Database option, click the Select button.
The Open dialog box appears.

2. In the File name box, type \\"name of server"\consoleservicedb
where "name of server" is the name of your Enterprise Edge server. If you
not know the name of ther server, ask your System Administrator.

3. Click the Open button.

4. Click ConsoleService.mdb

5. Click the Open button.
The database loads to your PC and the database path appears in the Current  
Database box.

6. Click the Close button on the top of the Reports window to return to the 
Attendant window.
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Selecting a report type
After you load a database, decide what type of report to produce.

To select a report type:

1. From the Report Type list box select your report.

Setting the report period
Some reports require a report period. The report period defines the time span
which data is considered. If you choose a report type that does not require a 
period, the Period list box is inactive. The report period begins on the From date 
ends on and includes the To date.

To enter the From and To dates:

1. In the From box type the date.
The following are acceptable date formats:

• June 5, 1997

• 6/5/1997

2. Press the Enter key.

3. Repeat for the To box.

4. Press the Enter key.

Note: An error message appears if you type a date in an unrecognized forma
you type a date that does not exist.

To escape from the From or To boxes:

1. Press the Tab key or the Esc key.
Enterprise Edge Attendant Console User Guide P0908544 Issue 01



Generating reports  81

ds.

 From 

 

 and 
, and 

 not 
e 

ou 
To specify a report of one week:

1. Click the One Week button.
The One Week dialog box appears.

2. In the month list box, choose the month that the desired week starts or en

3. In the year list box, select the year the week occurs in.
You can type the year box or use the arrows.

4. In the list of weeks select a week and click the OK  button, or double-click the 
desired week.
After you select a week, the start and end dates of the week appear in the
and To boxes.

To specify a report of one month:

1. Click the One Month button.
The One Month dialog box appears.

2. In the month list box, choose the desired month.

3. In the year select the desired year either by typing it or selecting it with the
arrows.

4. Click the OK  button to accept the month, or click the Cancel button to cancel 
your Report Period selection.

If you select a month, the start and end dates of the month appear in the From
To boxes. Dates for February automatically account for leap-years, centuries
millennia.

To cancel a selection, press the Esc key or click the Cancel button.
The Period list box information does not change.

Clearing a date

You can clear a date by deleting the contents of the box. A cleared box does
count as a date, and does not restrict the range of the other date by the abov
mentioned-rule.

Note: The To and From boxes are active if you select a valid database and y
select a Report Type that requires you to define a Report Period.
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Selecting employees and customers for the report
Some report types, especially those that deal with call data, allow you to choos
of employees, customers, or both, for which the data is summarized in the re
Reports make categories available that are appropriate to the type of report th
chose. If your Report Type does not need or allow these selections, the Empl
and Customers options remain inactive and you can go to the next step.

To select the Employees or Customers:

1. Click either the Employees or Customers option.
The Employee or Customer Record Selection dialog box appears.

Note: The first time you click one of these options after you connect to a datab
a wait cursor appears while Reports builds the directory. After Reports
builds the directory, if you click an option, a pause occurs while Repor
opens the dialog box. If a directory is large, the pause can be several se
long. After the pause, the Selection dialog box appears.

2. The Selection dialog box contains a list of Employees or Customers. The lis
Customers has a single column that lists the Customer’s Company Name
list of Employees has several columns that list the employee’s last, first an
middle names, and telephone extension. Resize the columns by dragging
column header edges in the bar at the top of the list.

3. You can choose either a single item or multiple items. Items that you sele
appear with a blue background behind their boxes. Choose a single item 
clicking it. Choose multiple items by holding down the Control key while y
select the items you want. You can select up to 100 items from the list. If 
require more than 100 items, do several reports with different selection list
click the All  button.

4. Click the OK  button.
The Customer or Employee Record Selection dialog box closes and the 
Selection list box displays the items you selected from the dialog box.
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Create Report button
When all the data needed to create a report is provided in the other report con
the Create Report button is available.

To create a report:

1. Click the Create Report button.
This starts the report generation process. The Reporting animated icon ap
indicating that the report is running. The icon stops when the report is com
plete.

Note: You cannot close the application while it is running. If you need to quit 
application while a report is running, you can do it from the Close 
Programs dialog box in the Windows Task Manager. Refer to Windows
Help for information on how to force programs to quit.

2. After the report is complete, it appears in the Report Viewing area below the 
Report controls. The Create Report button is unavailable again, indicating
the report is created. The Report controls are disabled and the keyboard 
functions only in the Report Viewing area. You can re-access the Report 
controls by pressing the Tab key.

Viewing the report you generated

After a report is created, the Page> and Page< buttons are available. The Pa
button shows the next available page of the report, if there is one, in the report 
The Page< button shows the previous page of the report, if there is one.

The page number of the current page appears in the bottom right corner of eac
of the report.

You can also change the displayed page from the keyboard.

To change the displayed page from the keyboard:

1. Ensure the keyboard is active in the Report Display area, in the lower hal
the Enterprise Edge Attendant Console Reports window. This is set automati-
cally after creating report, but can also be done by pressing the Tab key to 
move through the Report settings.

2. Press Ctrl  + Page Up to view the previous page, or Ctrl  + Page Down to view 
the next page.
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Printing a report
When a report is in the Report Viewing area, the Print button becomes availa

To print a report:

1. Click the Print  button.
The report prints to the default printer. You can change default printer from
Printers folder. Access the Printers folder from the Windows Start menu o
Control Panel. Refer to Enterprise Edge Attendant Console Help for furthe
information.

2. Choose the pages and number of copies of the report to print.

3. Click the OK  button and the report prints
or
click the Cancel button to cancel printing the report.

Note: If you change a Report Parameter in one of the Report Controls, the C
Report button is available and the Print button is unavailable. Do not cha
any Report Parameters before you print the report. If you change a Re
Parameter, you must regenerate the report before you can print it.
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Glossary

Assistant attendant

The assistant attendant is the telephone attendant who provides call coverag
specific employees.

Backup attendant

The Backup attendant receives calls when the main attendant is not available
main attendant uses the Out button on the Attendant main window to direct ca
the backup attendant.

BLF (Busy Lamp Field)

Busy Lamp Field is one of the Directory list tab views. It displays the phone statu
and extensions of employees.

CF

Call Forward.

Caller ID

Caller ID, known as CLID or Calling Line Identification, is provided by your 
telephone company. If your company subscribes to Caller ID, the caller name
number are displayed on incoming calls.

CO

Central Office.

CTA - Computer Telephony Adapter

A CTA is the hardware device used to connect a PC to the Enterprise Edge s
and includes the CTA 100, an external device, and the CTA 150i, which is inst
in a PC hard drive.

Destination extension

The destination extension is the person’s extension to which a caller (or atten
attempts to connect.

DND

Do not disturb.

DTMF - Dual Tone Multi Frequency

DTMF is the sound emitted when telephone buttons are pressed.

Enterprise Edge Attendant Console

Enterprise Edge Attendant Console is a Windows-based software product tha
provides call management and call activity reporting capability to a business.
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Enterprise Edge server

The telephone system that Enterprise Edge Attendant Console works with.

External call

An external call is a call that originates from outside your company’s voice mes
mailbox system.

Hookflash

This is the signal that occurs when a telephone goes on-hook followed by off-

Hunt Group

A Hunt Group is a group of telephones that can be called by a single number.
Groups are configured in your Enterprise Edge server.

ID 

Identification.

Internal call

An internal call is a call, such as a call from another employee’s extension, th
originates from your company’s Enterprise Edge server.

LAN

Local area network.

Main attendant

A main attendant is the telephone attendant who is primarily responsible for 
managing a company’s incoming calls. The main attendant can have other 
attendants.

Networked model

In a networked model the Enterprise Edge Attendant Console main attendant
is connected to one or more additional attendant PCs through a network.

Overflow attendant

The overflow attendant receives incoming calls when there are more than six a
calls at the main attendant’s PC.

PC

Personal Computer.

Server component

The Enterprise Edge Attendant Console Enterprise Edge server program sup
the Attendant component residing in the PC.

Shared system

In an Enterprise Edge Attendant Console shared system the Enterprise Edge
is shared by two or more companies.
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Stand-alone model

A stand-alone model is a Enterprise Edge Attendant Console system in which
attendant manages a business’s incoming calls. There are no assistant atten
backup attendants or overflow attendants in a stand-alone model.

Target extension

A target extension is the extension number to which you are directing a call.

VM

Voice mail or voice message mailbox.
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Ringing Assigned Extension 34

S
Save button 41
Screen Transfer 30
Screening calls 55
Search by department 69
Search for an individual 70
Selected extensions box 22
Selected tab

Directory list 22
Options dialog box 22

Selected tab view 42
Shared system 86
Standalone model 87
Starting the Attendant component 15
State/Province box 40
Status Bar 27, 29
Status box 27

T
Take button 21
Target box 37

finding an extension and moving it to 47
Target extension 87
Target menu 32
Telephone

managing calls at the employee’s telephone 
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